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Copyright 
 
©2002 Premier Assistive Technology, Inc.  All Rights Reserved.  This 
documentation and the accompanying software are copyrighted materials.  
Making unauthorized copies of this material is prohibited by law.  No part of the 
software or documentation may be reproduced, transmitted, transcribed, stored in 
a retrieval system or translated into any human or computer language without 
prior written permission of Premier Assistive Technology, Inc.  Premier Assistive 
Technology, Inc. asserts its "Moral Right" to be identified as the author of this 
work, in all jurisdictions which recognize the "Moral Right." 

  
Notice 
 

UNLESS OTHERWISE PROVIDED BY WRITTEN AGREEMENT WITH 
PREMIER ASSISTIVE TECHNOLOGY.  THIS PUBLICATION, AND THE 
SOFTWARE SOLD WITH THIS PUBLICATION ARE PROVIDED "AS IS" 
WITHOUT WARRANTY OF ANY KIND EITHER EXPRESSED OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FIT THIS PARTICULAR 
PURPOSE.  THE ENTIRE RISK ARISING OUT OF THE USE OR 
PERFORMANCE OF THIS PUBLICATION AND SOFTWARE REMAINS 
WITH YOU.  IN NO EVENT WILL PREMIER ASSISTIVE TECHNOLOGY 
INC., OR ANY OF ITS SUPPLIERS, BE LIABLE FOR ANY LOST PROFITS, 
LOST SAVINGS, DIRECT, INCIDENTAL OR INDIRECT DAMAGES OR 
OTHER ECONOMIC OR CONSEQUENTIAL DAMAGES, EVEN IF 
PREMIER ASSISTIVE TECHNOLOGY, INC, OR ITS SUPPLIERS, HAVE 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  PREMIER 
ASSISTIVE TECHNOLOGY, INC.  RESERVES THE RIGHT TO MODIFY 
THIS DOCUMENT AT ANY TIME WITHOUT OBLIGATION TO NOTIFY 
ANYONE. IN NO EVENT SHALL PREMIER ASSISTIVE TECHNOLOGY, 
INC. OR ITS SUPPLIERS' LIABILITY UNDER THIS AGREEMENT EXCEED 
THE SUM OF ANY AMOUNTS PAID HEREUNDER BY THE CUSTOMER 
TO PREMIER ASSISTIVE TECHNOLOGY, INC. OR THE SUPPLIER. 

 
Trademarks 
 

These other marks include, but are not necessarily limited to: WINDOWS, 
WINDOWS 95, WINDOWS 98, WINDOWS NT, and WINDOWS 2000, 
Windows ME, Window XP, which are registered Trademarks of Microsoft 
Corporation. 

 
You shall not use any of the Trademarks, or Service marks of Premier Assistive 
Technology, Inc., or Microsoft Corporation, or any other entity, without the 
express written permission of such Trademark or Service mark owner. 

 
Deletion or Modification 
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If any portion of this Manual, including but not limited to the "Notice" section 
above, is held to be unenforceable, then that portion shall be deleted, and the 
remaining language shall be given its broadest legal effect. 

 
 
Premier Assistive Technology, Inc. 
13102 Blaisdell Dr 
Suite D 
DeWitt, MI 48820 USA 
Phone: 517-668-8188 Fax: 517-668-2417 
E-mail: info@readingmadeeasy.com  
Web: www.readingmadeeasy.com 
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Quick Reference 
 

• Scan  Black and White    F5 Key 
• Scan Color      F6 Key 
• Create a New Document    CTRL+N 
• Cut Selected Text to the Clipboard  CTRL+X 
• Copy Selected Text to the Clipboard CTRL+C 
• Paste Text from the Clipboard    CTRL+V 
• Search for a Word    CTRL+F 
• Open a Document    CTRL+O 
• Exit the Application     ALT+F4 
• Copy Utility     CTRL+U 
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File Menu 
 
The File menu is used to manage documents.  Press the ALT+F keys to get to this 
menu. Once on the menu, you can use the up and down arrows to select the menu 
item you want, and then press Enter to activate it. 

 
New Document 

 
There are two ways to start a new document. You can select New from the 
File Menu or you can hold down the CTRL key and then press N. This 
will create a new document and give it the name of “untitled1”. If you 
have created more than one document without naming it, the system will 
give each document the name “untitled1”, “untitled2” respectively based 
on the number of unnamed documents that you have open. When you 
create a new document, it is automatically placed on the top. If you had a 
document already open, it will remain open, but will be underneath the 
new document. There is also an icon below the menu bar in the shape of 
blank white document that the user can click on the access a New 
Document. 

 
Opening a Document 

 
The Open option is similar to the New option in that it does nothing with 
the existing document.  It will open the document you have selected and 
place it on top.  All of the documents already open are still there and are 
stacked in the order that they were opened.  To open a document, select 
“Open” from the File Menu, or hold down CTRL+O. This will open up 
the Open File dialog box.  This is a standard Microsoft dialog box.  There 
is also an icon below the menu bar in the shape of an open manila folder 
the user can click on to Open a document.  

 

 
 

Use this dialog box to select the file that you want to open.  The default is 
a Microsoft Word-style document.  If you want to select a different type, 
press the Tab key until you get to get to the “File Type” drop down list 
box. From this list you may select from a wide variety of Types including 
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“Word”, “HTML”, “HTM”, “XML”, “Rich Text Format” and “ASCII”.  
Once you have found the file you are looking for, select the OK button 
and press Enter. 

 
 
Close  
 

The Close option is different than Exit. The easiest way to remember this 
is that you close a document and exit an application.  There are safeguards 
built into the Close feature.  If you try to close a document that you have 
made changes to, you will be prompted to save the changes.  If you have 
not given the document a name, the Save As dialog box will appear, 
prompting you to give the existing document a name.  See the Save As 
section of this manual for more information about the Save As function.  
A hot key for this feature is CTRL+F4.  There is also an icon on the tool 
bar of an open door, when selected this will close the file.   

 
Saving a Document 

 
There are two ways to save a document: (1) Save or (2) Save As.  If you 
have opened an existing document, you can use the Save feature.  You 
will not be prompted for a file name.  If you have not give the document a 
name yet when you try to save, it will prompt you for a file name and file 
type. When you select Save or Save As it will only save the active 
document. If you have made changes to more than one open document, 
you must go to each document and select Save to update that document. 

 
 

Save  
 

To save changes to a document, hold down CTRL+S.  You will only be 
prompted if an error occurs when you are trying to save a document.  If no 
message is displayed, the file has been saved successfully.  If you try to 
save a document and have not yet given it a name, you will be prompted to 
do so with the Save As dialog box.  See the Save As dialog box in this 
section for more information.  There is also an icon below the menu bar of 
a black diskette, clicking on this will save any changes made to the 
document. 
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Save As  

 
You will see the Save As dialog box in two different situations.  One is 
when you have created a document but have not saved it yet. When you 
save a document for the first time you must supply a file name, file type 
and a file location.  By default when you create a new document it is given 
the name Untitled and the file type is Microsoft Word, and the location is 
“My Documents”.  If the location and the type are OK, all you need to do 
is type in a file name.  The name can be up to 255 characters long and be 
any combinations of letters and numbers. You do not need to put an 
extension on the file (e.g. .doc or .txt); the system will automatically do 
this for you based on the type of file selected. 
 
If you attempt to give the file a name that already exists, you will get a 
prompt asking you if you want to overwrite the existing one.  If you select 
“Yes” the old file will be gone. 
 
You can also use the Save As to copy files.  You can open a document and 
then go to File, select Save As and give the document a new name.  It does 
not remove the old file; it only makes a copy of it. 
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Page Setup 
 

The Page Setup will allow users to adjust paper size and margin. The 
default document is Letter size paper 8.5” x 11.0” with 1” margins on all 
sides.  To select a different paper size, select it from the dropdown list. 
You will find most standard types listed. If you do not find one you can 
use, there is a catch all called “user defined”.  The user-defined format 
will allow users to enter any size paper.  When you adjust the paper size it 
is only for the active document. 

 

 
 
In addition to changing the paper size you can also adjust the margins. The 
default margin is a 1” border on each side. When you make changes they 
only apply to the active document. 
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Print Preview 

  
The print preview menu option will allow you to see what your document 
will look like when it prints. Go to the File menu and then select Print 
Preview to open up the Print Preview window.  
 

 
 

 
The Print Preview can display 1 or 2 pages at the same time; you can also 
zoom in and out. Select the Next button to go to the next page or two. You 
cannot edit the document in this window.  Click on the Print button to 
print and the Close button to return to the edit window.  Just under the 
menu bar is an icon the user can select to preview the print job. It is in the 
shape of a black document with a magnifier over it.  
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Printing 
 

You can print a document by holding down CTRL+P key. This will open 
up the Print dialog box. 

 

 
 

From the Print dialog box you select a printer, set the printer options, 
specify the number of copies you want and the pages you want to print.  
Once you have adjusted your settings, you can select the OK Button to 
print. There is also an icon in the shape of a printer under the menu bar.  
To print the user can also click on this icon.  

 
Exiting the Application 

 
There are two ways to exit the application. The easiest way is to press 
ALT+F4.  This will close the application. Before the application closes, it 
will go through each of your documents to check to see if any changes 
have been made.  If you have, you will be prompted to save changes 
before you exit the application. 
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Edit Menu 
 

The Edit menu is only available after you have opened or created a new 
document. On this menu you will find what you need to manipulate text, such as 
Cut, Copy and Paste. 

 
Undo 
 

The Undo function will undo the last change you made to the document. If 
you inserted an image, typed text, or changed formatting, you can select 
Undo and it will restore the document back to what it looked like before 
the last operation. Users should note that this function will only undo the 
last operation. 

 
Redo  
 

If you make a mistake and want to undo it, select the Redo function.  The 
Redo option is only available after you have selected the undo menu item.  

 
Select All 
 

You can select the entire text of the document by holding down CTRL+A.  
This will highlight the entire document.  Be very careful with the entire 
text highlighted, because if you press any key you could delete your entire 
document.  If that happens, however, you can select the Undo command 
and restore your document. 

 
Cut 

 
When you select Cut, it will remove the highlighted text from your 
document and place it in the Clipboard.  The Clipboard will hold this 
information until the next cut command is activated.  If you select Cut 
twice, only the last information will be retained on the clipboard. The hot 
keys for Cut are CTRL+X.  There is also an icon under the menu bar of a 
pair of scissors that the user can click to use the cut function. 

 
Copy  
 

The Copy feature is very similar to the Cut feature, except that it does not 
remove the highlighted text from the document.  Instead it makes a copy 
of it and places it on the clipboard.  The hot keys for Copy are CTRL+C.  
There is also an icon under the menu bar of two cascading pieces of paper 
that the user can select to use the copy function. 
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Paste 
 

When you use the paste feature it will paste whatever is on the clipboard 
into your document.  The information that is pasted from the clipboard 
will be placed where your cursor is.  To paste something from the 
clipboard, press CTRL+V.  There is also an icon under the menu bar of a 
clipboard and paper the user can select to use the paste function.  

 
 
Find 
 

You can search for a word or part of a word. To open the Find dialog box, 
click on the binoculars on the tool bar, or hold down CTRL+F.  This will 
open up the Find dialog box.  In the Find what edit box, type in the word 
or partial word you want to search for.  Before you select the Find Next 
button, you have two choices.  (1) You can select the Match Case check 
box.  If this is checked, the program will only search for words that match 
both spelling and case exactly.  By default, the Find feature will start 
searching from your current location to the end of the document. (2) If you 
want to search from your current location to the beginning of the 
document, make sure the Search Up radio button is selected.  Select Find 
Next to find the first occurrence of the word, and then continue clicking on 
the Find Next until you have found all occurrences of that word. 
 

 
 

Replace 
 

The Replace feature is very similar to the Find feature.  You can type in a 
word or partial word and then search for all occurrences of the word.  The 
only difference is that with the Replace feature you can search for a word 
or phrase and replace it with a different word or phrase.  You can select 
Replace, which will only replace the first found text.  The Replace All 
feature will search from beginning to end of a document replacing the 
search text with what is typed into the Replace With area. 
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Spell Checker 
 

The spell checker has an English dictionary with over 100,000 words.  To run 
spell check make sure the document you want to proof is displayed in the word 

processor window.  Start the spell checker by selecting it from the edit menu.  
You will know it has been started when you see the dialog window shown below.  

 
The spell-check dialog has one edit box, two list boxes and 11 buttons.  The spell 
checker will go through the document until it finds a word that is not in the 
dictionary.  When it finds one it will list all of the words that come close to 
matching the word.  The highest probable replacement first. 
 
The Check-Spelling Dialog appears if a word requiring your attention is detected. 
You can use the dialog to specify whether the word should be ignored or replaced. 
 
Add button: Causes the reported word to be added to the dictionary selected in 
the Add Words To list. Use the Add button if a correctly spelled word you use 
often is reported as a misspelling (e.g., your family name). If the word is not used 
frequently, you may want to select the Ignore or Ignore All buttons instead. 
 
Add Words To: This list indicates which User-Dictionary, words will be added 
to, when you select the Add button. The Add Words To list displays all User 
Dictionaries currently open. You can also add words to user dictionaries via the 
User Dictionaries Dialog, which is accessible by selecting the Dictionaries button. 

 
Cancel button: Stops the current spell-checking operation. 

 
Change button: Will change this and all following occurrences of the reported 
word to be replaced. If the problem word was edited, the edited word is used as 

 
-15- 



Text Cloner Pro 
User Manual 

the replacement. Otherwise, the selected suggestion is used as the replacement. If 
you want only this occurrence of the word to be replaced, use the Change button. 
If the reported word is one you frequently misspell, you might consider adding it 
to a user dictionary via the User Dictionaries Dialog. You can display the User 
Dictionaries dialog by selecting the Dictionaries button. 

 
Change All buttons: Will change this and all following occurrences of the 
reported word to be replaced with the word in the Change To box. If you want 
only this occurrence of the word to be replaced, use the Change button. If the 
reported word is one you frequently misspell, you might consider adding the 
misspelling and the correction to a user dictionary via the User Dictionaries 
Dialog. You can display the User Dictionaries dialog by selecting the Dictionaries 
button. 

 
Consider changing box: Contains a word which may be misspelled or otherwise 
incorrect, and is presented with a candidate replacement word. You can change 
the word by selecting the Change button, or skip it by selecting the Ignore button. 
Note that the label of this box changes to "Not in dictionary" when a misspelled 
word is detected. 

 
Dictionaries button: Causes the User Dictionaries Dialog to be displayed. You 
can use the User Dictionaries dialog to edit the contents of user dictionaries. 
 
Ignore button: Causes this occurrence of a misspelled word to be skipped. If the 
same misspelled word appears later, it will be reported. 

 
Ignore All buttons: Causes this and all further occurrences of a misspelled word 
to be skipped. You might use this button if the word reported as a misspelling is 
actually spelled correctly. If the word is one you use frequently, you may wish to 
ignore it permanently by selecting the Add button. 

 
Problem box: Contains the misspelled word. The label of this box changes with 
the type of problem detected. “Not in dictionary” indicates that a misspelled word 
was detected; the word is considered misspelled because it could not be located in 
any open dictionaries. “Consider changing” indicates a word was encountered 
which was marked with a conditional-change action in a user dictionary. 
Capitalization indicates the word is spelled correctly but needs to be capitalized. 

 
Options button: Causes the Options dialog to be displayed. You can use the 
Options dialog to set spell-check options. 

 
Suggest button: Search more thoroughly for suggested replacements for the 
current misspelled word. Each time you press the Suggest button, a "deeper" 
search is made. The Suggest button is disabled once all possible suggestions have 
been located. 
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Suggestions list: Contains a list of suggested replacements for the word reported 
as misspelled. Subsequent presses of the Suggest button may yield more 
suggestions. The word selected in the Suggestions list will be used as the 
replacement when the Change or Change All buttons are pressed, unless the word 
in the problem box was edited. 

 
Undo button: Removes the last change made. The Undo button can be pressed 
several times to remove the last several changes. 
 
Undo Edit button: Remove any changes made to the text in the problem box. 
This button appears only if the text in the problem box has been changed. 

 
 

Thesaurus 
 
The Thesaurus can be used to look up synonyms to other words that you find in 
the body of your text document.  To use the Thesaurus function, simply highlight 
the desired word in your text document and select the Thesaurus function from 
the EDIT menu.  The following type of dialog box will appear  

 

 
 

In this example, highlighting the word “clear” and selecting the Thesaurus 
function presents you a list of the words that are similar in meaning to the word 
“clear”. 
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View Menu  

 
Outline view shows the document's structure. The indentations and symbols in 
Outline view do not affect the way your document looks in “Normal view” and 
will not appear on the printed version. 
 
Normal 

  
This will keep your layout in the Normal (classic), Full Screen mode.   

  
Print Layout 

  
This will show the layout of the page on your monitor to the left side.  

 
Centered Page Layout 

  
This will center the page on your monitor. 

 
Header/Footer 
 

Headers and footers are typically used in printed documents. You can 
create headers and footers that include text or graphics — for example, 
page numbers, the date, a company logo, the document's title or file name, 
or the author's name — that are usually printed at the top or bottom of 
each page in a document. A header is printed in the top margin; a footer is 
printed in the bottom margin. 
 
You can use the same header and footer throughout a document or change 
the header and footer for part of the document. For example, use a unique 
header or footer on the first page, or leave the header or footer off the first 
page. You can also use different headers and footers on odd and even 
pages or for part of a document. 

 
Tool Bar 
 

A toolbar can contain buttons with images, menus or a combination of 
both.  These built-in toolbars can be displayed or hidden as needed. 
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Paragraph Bar 

 

The paragraph mark contains all of the formatting for that first paragraph. 
You can change paragraph formatting either by selecting the paragraph 
mark and setting its formatting attributes before you start typing, or by 
typing your text, selecting it along with the paragraph mark, and then 
changing the text's formatting.  

When you press Enter to end one paragraph and begin another, the 
resulting new paragraph has the same characteristics as the previous one. 
For example, to make all the body paragraphs in your document left-
aligned and double-spaced, you only have to set those attributes for the 
first paragraph. Pressing Enter carries the formatting over to the next 
paragraph. You can hide or show paragraph marks and other formatting 
marks by clicking on the bar. Showing paragraph marks helps you see 
where each paragraph ends and makes it easier to select the formatting 
characteristics you want to change. 

 

 
Ruler 
 

This bar is automatically formatted as shown and allows you to see where 
you are in your document and on your page.  To turn OFF the ruler 
function, click Ruler on the View Menu.  
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Status Bar 

The status bar, which is a horizontal area at the bottom of the document 
window, provides information about the current state of what you are 
viewing in the window and any other contextual information. To display 
the status bar, click the View dropdown menu, and then select Status bar. 

 
Item Shows 

Page The page number of the page shown based on the 
page numbers you gave the document, if any. 

Section  The section number of the page shown in the 
window. 

Ln The line of text where the insertion point is located. 
No measurement is displayed if the insertion point is 
not in the window. 

Col The distance, in number of characters, from the left 
margin to the insertion point. No measurement is 
displayed if the insertion point is not in the window. 

 
 

Control Characters 
 

Control Characters are marks that are inserted in right-to-left and mixed 
text (e.g. Arabic or Asian languages) to specify the formatting of text 
when the inherent directionality of the text is insufficient to display 
expected results. 

 
Zoom 
 

You can "zoom in" to get a close-up view of your document or "zoom out" 
to see more of the page at a reduced size.  Go to the View Menu, select 
Zoom and then select Size or select the Zoom from the paragraph bar. 

 
 
Insert Menu 
 

Text 
 

This allows you to select a file to insert in your document. Click on the 
View Menu, enter File Name and hit Open.  
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Image 
 

To insert an image into your document, position the cursor where you 
want the image to appear.  Go to the Insert menu and select Image. You 
will have two options, (1) As Fixed Object or (2) At Caret Position. Either 
will pull up an Insert Image dialog box. You may select from multiple 
image types.  

 
As Fixed Object:  This inserts the image as an immovable object. Any 
other adjustments you make to the document will not move the image, 
only the elements around it. You will still have the option to manually 
move the image, by clicking on it to highlight it and then dragging it to the 
new location. 
 
At Caret Position: This option inserts the image as a moveable object. 
When you continue to edit your document, the image can be moved along 
with text and other elements. You may also manually move the image by 
clicking on it to highlight it and then dragging it to the new location.  

 

 
 

Object 
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Where Insert Image places a graphic into your document, Insert Object 
allows you to insert graphical or non-graphical elements, such as a 
spreadsheet, video clip, organizational chart, or clip art.  To insert an 
object into your document, position the cursor where you want the object 
to appear.  Go to the Insert menu and select Object. You will have two 
options, (1) As Fixed Object or (2) At Caret Position. Either will pull up 
an Insert Object dialog box. You may select from multiple object types.  

 
As Fixed Object:  This inserts the object in a fixed position. Any other 
adjustments you make to the document will not move the image, only the 
elements around it. You have the option to manually move the object by 
clicking on it to highlight it and then dragging it to the new location. 

 
At Caret Position: This option inserts the object as a moveable element. 
When you continue to edit your document, the object can be moved along 
with text and other elements. You may also manually move the object by 
clicking on it to highlight it and then dragging it to the new location. 
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Page Break 

 
When you fill a page with content, Text Cloner Pro inserts an automatic 
page break and starts a new page. To force a page break at a specific 
location, you can insert a manual page break. 
 
However, if you insert manual page breaks, you might have to frequently 
re-break pages as you edit the document. Instead, you might want to set 
pagination options to control where Text Cloner Pro positions automatic 
page breaks. 
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Format Menu 
 

Character 
 

A dialog box like the one below will appear.  From here make any 
changes needed. To apply character formatting to a single word, select the 
word. To apply character formatting to several words or a few characters 
within a word, select the text you want to change. 
 

 
 

Paragraph 
 

In the Text Cloner Pro, a paragraph is a distinct unit of information that 
has its own formatting characteristics, such as alignment, spacing, and 
styles. A paragraph is always followed by a paragraph mark.  From the 
dialog box, select what changes you need.  To keep those changes, select 
OK.  To cancel, select Cancel and no changes will be made.  
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Bullets and Numbers 
 

You can add bullets to existing lines of text or you can create a bulleted 
list automatically as you type. If you begin a paragraph by typing a hyphen 
(-) or an asterisk (*) followed by a space or a tab and some text, Text 
Cloner Pro automatically converts the paragraph to a bulleted item when 
you press ENTER to end the paragraph. This type of bullet uses a 
character font. You can add numbers to existing lines of text or you can 
create a numbered list automatically as you type. If you begin a paragraph 
by typing “1.”, pressing SPACEBAR or TAB, and then typing some text, 
the program automatically converts the paragraph to a numbered list item 
when you press ENTER to end the paragraph.   

You can also choose to increase or decrease the level of the bullets and 
numbers…for example if you are on A, B, C, (large characters) as the type 
of the bullets or numbering you have chosen, and you select increase, the 
next line will be increased to a, b, c, (small characters).  If you select 
decrease, the next line will begin with 1, 2, 3, (numbers). See dropdown 
list for order.  
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Tabs 
 

To select the tab position, select Tabs from the Format dropdown menu 
and choose the positions.  To select the desired alignment, click on Left, 
Center, Right or Decimal. To keep changes, select or click OK.  To exit, 
select or click Cancel.  Select Clear to clear one tab or Clear All to clear 
all tab settings. 

 

 
 

Style  
 

The Style list on the Formatting dropdown menu, also known as the Style 
Preview, shows many formats associated with your styles. 
 

Attribute Explanation 
Left-indented style 
name 

Shows whether left-aligned text is indented 
negatively or positively from the left margin. 

Font size of style 
name 

Reflects the exact font size of the style if it's 
between 8 pt. and 16 pt. Word displays smaller 
type in an 8 pt. font and larger type in a 16 pt. 
font. 

Four horizontal lines Represents left, right, centered, and justified 
alignment. 
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Scan Menu 
 
Text Cloner Pro is a MDI style application. This allows you to have more than one 
document open at a time.  You can switch between open documents by holding down 
CTRL key and then pressing the TAB key.  While multiple documents can be open at the 
same time, only one document can be active at a time. 
 
There are two modes of scanning in version seven of text Cloner pro; high speed, and 
high detail.  The high speed scanning works well for about 80 to 90 percent of what a 
person reads.  It is designed to quickly scan and get information into the computer.  Since 
what most people scan are books novels and general reading literature, the high speed can 
quickly decipher the information and put it on the in a 1/3 the time of detailed scanning.   
You would use the detailed mode for those more complicated documents with colored 
background water marks and tables.   
 
Text Cloner 7 allows users to have to default modes of scanning. Each one of these 
modes is activated by a different hot key. For high speed scanning press the F5 key and 
for high detail scanning press the F6 key.  By having two distinct keys you can have the 
detailed scanning set up for scanning tables, and the high speed set up for book scanning. 
Once you have your defaults set switching between high speed and a detailed scan is just 
a matter of which button you press.  Since most text is laid out in standard columns most 
reading can be done with high speed scanning.   If you are not sure how complicated the 
document is press F5 and see the results, if you are not happy with them press f6 to see if 
the high detailed scanning will give you better results. 
 
 

Scanning 
 

To scan a document – first put the document on the scanner, and then press the F5 
key.  The scanner will then scan the page.  It will tell you when the document is 
ready for reading.  The text will be appended to the current document.  When the 
document is done, your cursor will be placed at the end of the previous text and at 
the beginning of the new text.  If this is the first scan, it will be placed at the 
beginning of the document.  The system will notify you if it does not recognize 
any text or the page is blank. 
 
Press F5 for high speed black and white scanning High speed works great for 
most documents; it can handle multiple columns, and most layouts including 
novels where it will scan both pages and will put them in correct order. It will 
work with pages that have images but the images will be omitted from the final 
document.  For more details on the high speed scanning options go to the Black 
and White scanning features section of this document. 
 
High Speed scanning is optimized for most documents that contain standard fonts 
printed on a white back ground  

 

 
-27- 



Text Cloner Pro 
User Manual 

For mouse users: use your right mouse button and click anywhere in the 
document and then select scan from the popup menu with the left mouse button. 
 
Press F6 for the more complicated documents.   Detailed scanning such as tables 
or documents on colored back grounds.  If you used the detailed mode and there 
are pictures on the page they will be include in the final output.  For more 
information on the detail scanning features go to the Color Scanning features later 
in this document. 
 

 
Select Scanner 

 
The system will use the default scanner.  If you have more than one scanner, you 
may select which one you want to use.  To select a different scanner, press ALT + 
S to select the scan menu.  Use your down arrow until you are on “Select 
Scanner” and press the enter key.  A dialog will appear with a list of all the 
identified scanners on your system.  Select the one you want and press the 
ENTER key. 
 
For mouse users: use your left mouse button and click on the Scan menu and then 
use your left mouse button and click on the “Select Scanner” menu item. 

 
Black and White options 

  
To Scan using black and white mode press F5. The black and white options are 
used to adjust the scanning and OCR properties of the high speed scanning.  
When using the high speed scanning option you have the choice of three different 
material types.  By telling the scanner what type of material it is scanning, ell 
think of it this way. If I give you directions where to look for something, it should 
take you less time to find it, that is in essence what your are doing in the black 
and white mode.  The less time the computer spends looking for text the more 
time you can spend reading.  So by telling the computer what it is scanning, the 
whole process will be sped up, because the computer does not have to compute 
every different iteration. The high speed scanning ignores images and is only 
interested in the text, thus scanning is faster and recognizing faster. 

 
Material type 

 
Magazine – Magazine is the default.   Magazine is the format most used.  It will 
recognize and de-columnize and de-hyphen the text to allow the screen reader to 
read content smoothly.  Magazine type will recognize documents if they are 
rotated 90, 180, or 280 degrees and automatically correct it. It can recognize 
pages with up to 5 columns, and it can automatically separate up to 3 different 
articles on a single page. 
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Book - book is the least used of the three. It was originally implemented for 
individuals who read novels, and small books that just have text.  If you have a 
fast computer you will not see much speed difference between book and 
magazine.  Book will automatically rotate the page 90, 180 or 270 degrees. It can 
recognize if two pages have been scanned and will put the correct page after each 
other.  If you have a newer computer say less than 4 years old I would 
recommend that you just leave this setting on magazine. 

 
Other – Other is just that.  Some times you want all the text to be left where it 
supposed to be in a document, like a phone book you want the names to be 
directly across from each other.  Other will automatically determine the 
orientation of the page and rotate it 90, 180 or 270 but that is all it will do. It will 
not remove the columns  

 
Contrast 

 
 

The professional version of Text Cloner will allow you to adjust the contrast to 
obtain better character Recognition.  If you set it to zero text Cloner will us the 
auto contrast feature.  If you want to manually adjust it you can change the 
settings from + 1000 t0 –1000. 

 

 
 
 

Color Options 
 

To scan using color mode press the F6 key. From time to time you run into documents that have 
tables, or have been printed on a colored back ground, or may even have pictures that you want in 
the output file.  This is what the color mode is for. When you use the color mode it scans the 
document in using color, this way the computer can start to find the differences in color. If you 
have green text on a black back ground and scan in black and white mode the computer only sees 
all black and cannot find the text. When you scan using color it takes a bit longer than with black 
and white.  Once the image is in your computer   the image will be checked for color, orientation 
of the page, and try to decipher the information.  With today’s faster computers, this process only 
takes a few seconds but if you multiply that to a couple hundred pages it adds up. 

 
Output Type  
 
Text Cloner offers three different type of output. In color mode You can have (1) 
Text, Tables and Images (2) Text and Images, and (3) Text Only.   When you 
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select an output type, that type will remain the default, until you change it.  Text 
and Images is the default. 
 
Text, Tables and Images: Then you text tables and images selected this gives 
you the most robust scanning option.  It will put all the text into continuous 
reading format, as well as keeping the tables in a screen reader accessible format.   
This is the best for scanning in forms, books with complicated pages and bills. 
 
Text and Images:  Text and Image is ideal for books and magazines.   This will 
not look to identify tables, which makes it a bit faster for scanning.  However, on 
newer machines you may not even notice the difference in speed. 
 
Text Only:  Text Only will ignore all images and tables and just give you 
straight text in continuous reading format.  This is the fastest form of recognition. 
Text Cloner Pro 6.0 now supports three different types of scanners.    
 
Color ADF Support 
 
Scanners without Document Sheet Feeders which is the case for most scanners.  If 
you do have an ADF it will support both single and double-sided ADF.   The 
default is Document Plate.  This will work with all scanners and it will scan what 
ever is put on the glass of the scanner.   If you do have an ADF just select the one 
that is appropriate for your scanner.  Most people do not need to change this 
setting. 
 

Document Plate 
ADF Single Side 
ADF Double Sided 

 
Recognize From Image 

 
Text Cloner Pro can recognize text from pre-scanned images.  These images can 
be either single or multi-page scans; Text Cloner Pro will automatically recognize 
them.  When you recognize from an image, it will add the text to the current 
document.  If you want the text from the image to be in a separate document, you 
will need to create a new document first, therefore, press CTRL+N.    
 
To recognize from an image, go to the scan menu Alt+S and select the menu item 
called “Recognize From Image”. The open dialog box will appear.  This is a 
standard window dialog box. 

 
-30- 



Text Cloner Pro 
User Manual 

 
 

You can open up GIF, Tiff, BMP, JPEG and FMF (fax format) documents.   To 
select the type of image file you want, select the file of type drop down list and 
select the desired type.  Once you have selected the file, press ENTER or select 
the OPEN button.  Text Cloner will do the rest and within a few seconds the text 
will appear on the screen. 
 

 
 

Show Scan Progress.   
 
If you want to see the progress of the scanner place a check mark in font of this 
option.  If you do not want to see the progress bar just remove the check.  By 
default this is not selected. 

 
 

Notify Me After Each Scan 
 

If this menu option is check you will receive a message every time the scan is 
complete. If you uncheck this option you will not be notified.
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View Image 

 
With Text Cloner Pro you can View, Print, Save Open, and Rotate scanned 
Images. To view a scanned image, press ALT+S to go to the Scan menu. Once on 
the scan menu, use your arrow keys to go down to the menu item “View Image” 
and press the ENTER key.  The View Image window will open.  Once you have 
the View Image window open, you have the following options. 
 

 
 

Print Image 
 

The first button is the print button. When you select this button, it will print out 
the image that was scanned.  The image is designed to print on a 8.5” x 11” sheet.  
The image is scaled to fit within the boundary of the printer.  It will only print in 
black and white.  Press ALT+P to activate this button. 

 
Save Image 

 
You can save the image that you have scanned as one of over 40 different image 
types.  When you select SAVE, the save dialog box will open. This SAVE dialog 
box is similar to all the other dialog boxes.   You must specify where you want the 
image to be saved.  You must give it a file name and you must also select a file 
type.  To activate the SAVE button, press Alt + S. 
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Zoom Image 

 
The ZOOM feature allows you to toggle between two views. When you select this 
button, you can switch between the Normal View and the Scale to Fit View.  In 
the normal view, you will be able to use the scroll bars to pan up and down or left 
and right to see the enlarge image.  When you select the Zoom button, the display 
will switch you between theses views. The “scale to fit” view will display the 
complete image in the windows. 

  
Open Image 

 
Text Cloner Professional will allow users to open up existing images from which 
you wish to clone text.  Select the OPEN button to open the Open Dialog Box.  
This dialog box is very similar to all other Windows open dialog boxes. This 
dialog box will allow you to select and open virtually any image.  All you have to 
do is select the file and the dialog box will determine if it is an image and what 
kind of image it is.  If you open an image in this window and then close it, the 
image you have opened will replace the one that was previously scanned in. 

 
Rotate Image 

 
The Rotate button will rotate the displayed image by 90 degrees every time it is 
selected. So if you wanted to rotate an image by 180 degrees, you would have to 
select the rotate button. When you print out an image, it will print out the way it is 
displayed on the screen. 

 
Close Image View 

 
The close button will close this window. If a new image has been opened, it will 
replace the image that was previously scanned in. 

 
 

Contrast 
 

Text Cloner Pro will allow you to adjust the contrast to obtain better character 
Recognition.  If you set it to zero, Text Cloner will us the auto contrast feature.  If 
you want to manually adjust it, you can change the settings from + 1000 to –1000. 
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Insert Page Break after Scan 

 
When the Insert Page Break After Scan is selected, a page break will be inserted 
between each scan after the first page.   This option can be turned on and off will 
scanning. To toggle this option, press the spacebar once. 

 
Insert Scan at Cursor 

 
When you have this option selected, you can insert a scan where your cursor is 
currently located. If you wanted to insert a page, move your cursor to the spot 
where you want to insert the text and then press the F5 key.  This will scan the 
image and insert the text right where the cursor is. When it is finished, it will 
move the cursor to the end of the inserted text.  If you want to insert a  two-page 
document, you would not have to reposition the cursor.  This option is not 
retained.  When you close the document and then open it back up you will have to 
recheck this option if you want to insert more text. 
 
Reset OCR 

 
If you ever get an error messaged that tells you that the OCR engine cannot be 
found.  You can fix this by selecting the Reset OCR.  This will reinitialize your 
OCR engine. You may need to exit Text Cloner and then get back into it in order 
to take effect. 
 
 
Copy Utility 

 
Text Cloner Pro is now equipped with a copy utility that makes making copies 
with your scanner and printer easy.  To open the Copy utility, press CTRL+U.  
The Copy utility consists of one edit box and two buttons.  To make a copy, place 
a document on the scanner, enter the number of copies you want and then press 
the Copy button. When you are, done select the Close button.  This copy utility is 
a full color copier.  Therefore, if you have a color printer, you will get color 
copies.  Otherwise, all images will print in black and white. 
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Table Menu 
 

A table is made up of rows and columns of cells that you can fill with text and 
graphics. Tables are often used to organize and present information, but they have 
a variety of other uses as well. You can use tables to align numbers in columns, 
and then sort and perform calculations on them. You can also use tables to create 
interesting page layouts and arrange text and graphics.  

 
Insert 

Allows you to insert a table; a dialog box like the one below will appear 
and the user can select the number of rows and/or columns needed.  Then 
click OK to keep the table attributes. To exit without creating a table, click 
Cancel. 

 

 
 
Select 

This allows the user to select a row, column or the entire table to make 
changes.  To use, create a table and select from the dropdown list which 
part you want to modify (table, row, or column), and then make your 
changes.  

 
Delete 

This allows the user to delete a row, column or the entire table.  To delete, 
click inside the table, then select from the dropdown list, which you want 
to delete.   

  
Grid Lines 

If this is checked, all grid lines will show on the table.  If not, no grid lines 
will be visible. 
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Properties 

 
The dialog box below allows the user to change any properties of the table, from 
the width of each line to the background.  To save changes, click OK.  To exit 
without saving changes, click Cancel.  
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Window Menu 
 

Shows the way the window is presented on the screen.  See below for examples of 
the different layouts.  
 
Cascade 

This shows the open windows in drop down layers with the most recently 
used application window in the front. 

. 
 

Tile Horizontally 
 

This shows the open windows directly horizontal to one another and the 
one most recently used will be on top.  
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Tile Vertically 
 
This shows the open windows directly vertical or side-by-side to one 
another with the one most recently opened highlighted to the far right.  

 

 
 

Arrange Icons 
 

This feature will arrange the icons on your menu and tool bars.  
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Help Menu 
 

This entire manual is located in the help file. There are three ways to open the 
Help menu.  Press F1, select the Help icon on the tool bar (a purple book with a 
question mark on it) or ALT+H to open the Help menu and then select Help.  This 
help file is in the traditional Microsoft Windows Help File format. 

 
Contents 

 
 This feature allows the user to get the contents of the Help file.   

 
Load User Manual 

 
 This will load the user manual onto the screen for you to read. 

 
About 

The Help About box is a small window that tells you what version number 
you have and contact information for Premier Assistive.  To open the Help 
About window, press ALT+H to open the Help menu and then select Help 
About.  To exit this window, press the Enter key. 
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System Requirements 
 

CPU:  350 Mhz Pentium Processor or Faster (300 or faster is 
recommended) 

 Memory: 128 MB or higher is recommended) 
 Sound Card:  16 Bit with Speakers 
 Key Board:  Standard 104 Key 
 Disk Space:  92 MB of Free Disk Space 
 CD-ROM:  4X or faster 
 
    
  

Operating Systems: Windows 98, Windows 2000, Windows NT 4.0 with service 
patch 5, Windows XP Home/Pro.  It may work with Windows 95, but we do not 
support Windows 95. 
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Page Break, 23 
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Paste, 14 
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Print Preview, 11 
Printing, 12 
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Redo, 13 
Replace, 14 
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S 

Save, 8 
Save As, 9 
Saving a Document, 8 
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Select, 35 
Select All, 13 
Spell Checker, 15 
Status Bar, 20 
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T 

Table Menu, 35 
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Tool Bar, 18 
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Undo, 13 
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View Menu, 18 
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Window Menu, 37 

Z 

Zoom, 20 
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